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Вступление
При написании современной музыки используются семплы. Это относительно небольшой звуковой фрагмент.  На сегодняшний день существует огромное количество всевозможных семплеров, ромплеров и подобных устройств. При работе с данным рефератом, я рассмотрел множество программ для обработки этих звуков, с которыми вы можете ознакомиться на следующих страницах.


Глава 1: Сэмплы
Как было написано ранее, сэмплы-это звуковые фрагменты. Важно знать две важных характеристики сэмплов: разрешение, то есть число битов, и частота дискретизации (сэмплирования). Число битов сэмпла определяет его способность различать уровни амплитуды сигнала, большое число битов позволяет воспроизводить оцифрованный звук более качественно и точно. Частота сэмплирования напрямую связана с наивысшей частотой, которая может быть воспроизведена сэмплом. Например, сэмпл с частотой дискретизации 40 kHz (40.000 Hz) может воспроизвести звук с частотами до 20 kHz. Это означает, что низкий коэффициент сэмплирования может быть использован для оцифровки басов, низкочастотных звуков. В то время как для воспроизведения высокочастотных звуковых сигналов  требуется высокой частоты сэмплирования.
Другой аспект модуля/трека — это максимальный размер сэмпла, который нужно использовать в треке. В настоящее время некоторые редакторы и трекеры поддерживают от минимальных 64Kb до виртуально неограниченного размера сэмпла. Из основных характеристик трекеров можно увидеть, что в большинстве случаев они имеют ограничения на размер сэмпла, а не тип модулей, в которые могут сохранять данные. Существует один из приемов, решающих проблему невозможности использовать сэмпл большой длины — это loop (петли). Хорошо размещенная петля на семпле может использоваться для увеличения длины звучания сэмпла. Если границы loop области отмечены аккуратно, то «место склейки» практически незаметно. Часто можно применять эффект sustain.
Формат сэмплов является одной из наименее понимаемых областей работы с модулями. Особенно SAM и SMP. Стоит заметить, что расширение файла легко можно изменить в любой операционной системе, поэтому оно не может служить идентификатором типа сэмпла. Поэтому тип сэмплов нужно определять по последовательности байтов в заголовке сэмпла (внутри файла). Но это не всегда возможно. SAM и SMP не имеют заголовка. В них размещаются только звуковые данные. Используя их, трекер декодирует их в 8-битные знаковые данные сэмпла. Обычно тон сэмпла и информация о loop границах сохраняется в модуле. Единственная возможность обмениваться сэмплами с loop установками и определенной частотой дискретизации — это сохранять их в модуле и обмениваться модулями.
Программы на которых делается музыка из сэмплов: Ableton Live, Cubase, Logic Pro, Fruty Loops, Sony Acid, Pro Tools и д.р
Сэмплы хорошо используется диджеями для создания клубной, транс, техно музыки. Путем подбора сэмплов по тональности, ритмичности получается готовая музыка без потери времени и с очень хорошим качеством звучания.


Глава 2: Обработка звука
Обработка звука бывает разноплановой и зависит от целей, которые вы преследуете. Это может быть подавление шумов, наложение звуковых фильтров, добавление реверберации или дилея, выведение на передний план определённых частот и т.п. 
Наиболее необходимой и практически повсеместно используемой процедурой является подавление шумов. Шумы могут быть как внешними, случайно записанными на микрофон фоновыми звуками в помещении с плохой звукоизоляцией, так и внутрисистемными, возникшими вследствие плохого экранирования шнуров и прочего звукозаписывающего оборудования. Шумы имеют свои частоты, диапазон которых сравнительно узок. Это позволяет подавлять их путём простой эквализации, то есть – убирать частоты, на которых больше всего шума и меньше всего нужных звуков. Запись, на которой шумы занимают сравнительно небольшой диапазон, не соприкасающийся с диапазоном других звуков, считается чистой. Запись, на которой шумы звучат почти на всех частотах, считается грязной, так как их практически невозможно подавить без ущерба для нужных звуков. 
[image: Подавление шума]
Подавление шума с помощью плагина Noise Reduction в редакторе Sound Forge
Реверберация считается вторым по востребованности шагом в обработке звука. Реверберация – это постепенное затухание звука, например, в большом помещении с хорошей акустикой. При небольшой продолжительности она добавляет вокалу или сольным инструментам глубину и выразительность звучания, поэтому её используют довольно часто. В отличие от простого эха, которое просто повторяет звук несколько раз, при этом, затихая, реверберация прогрессивно меняет соотношение частот повторяемого звука, что может создавать самые разнообразные эффекты. 
После реверберации по популярности, пожалуй, стоят дилей-эффекты. Или попросту задержки звука. Это может быть как обычное эхо любой частоты затухания, так и более изысканные дилеи. Особенно дилей может понадобиться при обработке моно-звука и превращении его в псевдостерео. Для этого производится совсем незначительная задержка звука в одном из каналов. При этом одному каналу желательно добавить немного «сухости» (средних частот). Тогда бывший моно-звук начинает звучать в разных каналах и чуть-чуть по-разному, что и создаёт эффект стерео. 
Если прибавить немного высоких и средних частот и совсем не использовать реверберации и дилея, то создаётся популярный в последнее время «эффект присутствия», как будто вокалист поёт прямо в вашей комнате. 
Фильтры – это эквализационные схемы, которые накладываются на записанный звук. Фильтры бывают статические и динамические. Статические фильтры просто убирают некоторые частоты трека, добавляя другие, а динамические постоянно меняют соотношение частот по определённой круговой схеме, из-за чего звук кажется «плавающим». 



Глава 3: Обзор программ для обработки звуков
Рассмотрим несколько наиболее известных звуковых редакторов. Но, как всегда, кроме известных продуктов, еще существуют и малоизвестные. Во-вторых, известные именитые программы стоят немалых денег, поэтому возникает вопрос поиска бесплатной или более доступной альтернативы. И, наконец, в-третьих, этим рефератом я хочу свести в одну статью специфику и особенности различных звуковых редакторов. 
Глава 3.1: Audition 2.0. Редактор звука от Adobe
Для начала рассмотрим , так сказать, стандартную качественную программу от известного всем разработчика Adobe. У неея нашел только 1 минус-она не бесплатная, но существует множество кряков на нее.
Первым бросается в глаза конечно же интерфейс. На весь рабочий стол распространено его пространство. Иконки на панели инструментов дают понять что продукт без сомнений от Adobe. Все логично разложено по полочкам. Слева - браузер файлов и эффектов, посередине - рабочее окно, внизу - управление и индикаторы (рис. 1). Но основным удобством яляется то, что мы можем подстраивать его под себя, перемещая окна так как нам нравится. Можно, к примеру, вынести индикаторы на место редактирования файла и наоборот, или вообще убрать их. Чтобы не потеряться можно контролировать открытые окна во вкладке Window на панели инструментов. 
[image: Рисунок 1 - Основоное окно Audition 2]
Рисунок 1. Основоное окно Audition 2
Как видим, интерфейс строгий, но довольно удобный. Сразу скажу об основной "фишке" Audition 2. Фактически программа состоит из трёх больших частей: первая - редактирование файлов, вторая - мультитрековое редактирование (аранжировка) и третья - запись на CD. Переключение этих режимов вынесено на самое видное место - посередине панели инструментов (рис. 2). Будем рассматривать каждый режим в отдельности. 
[image: Рисунок 2 - Переключение режимов работы]
Рисунок 2. Переключение режимов работы
Режим Edit
Чтобы переключиться в этот режим нужно нажать на кнопку Edit (рис. 2). Перед нами основное окно, пока еще пустое. Для добавления файлов обращаемся к браузеру файлов (на панели слева). Можно добавить в браузер несколько файлов, причём при добавлении файла в браузер создаётся файл-образ формы волны, что требует дополнительного времени, зато потом при перетаскивании в окно редактирования это время не расходуется. Кроме того файлы в браузере можно сортировать по своему вкусу. 
Заглянем теперь во вкладку Effects. Обращаю внимание на то, что эффекты делятся на 3 категории. Мультитрековые (multitrack effects), нас они пока не интересуют, эффекты реального времени (realtime effects) и эффекты процессинга (process effects). Обьясняю разницу между эффектами процессинга и реального времени. Эффекты реального времени позволяют изменять параметры и сразу же прослушивать результат, нажав кнопочку Prevew play (рис. 3). 
[image: Рисунок 3 - Кнопка preview play в окне эффекта реального времени]
Рисунок 3. Кнопка preview play в окне эффекта реального времени
К примеру, эффект Pitch shifter - эффект реального времени. Запуская прослушивание в нем мы можем менять высоту, а потом нажав ОК применим эффект к файлу. В категории эффектов процессинга есть похожий эффект - Pitch bender. Но здесь мы сначала делаем настройки, а потом нажимаем кнопку Preview и слушаем изменения. Разница в том что Pitch bender может изменить высоту плавно или по какому-то графику, а Pitch shifter с определенными статичными параметрами. 
Также все эффекты расположены на панели инструментов в соответствующих вкладках. Еще хочу обратить внимание на нюанс, касающийся многих редакторов. Если мы выделяем фрагмент и запускаем эффект, то он применится только к этому фрагменту, если выделения нету - ко всему файлу. 
Также есть такая полезная функция как Mastering rack (Effects>Mastering rack...) (рис. 4). 
[image: Рисунок 4 - Окно Mastering Rack]
Рисунок 4. Окно Mastering Rack
Mastering rack удобен тем, что здесь можно загрузить несколько эффектов, в реальном времени корректировать их и одновременно прослушивать. А затем применить получившийся результат. 
Программа также поддерживает DirectX и VST плагины. Настройка директорий и активация плагинов находятся во вкладке Effects на панели инструментов. 
При очень высокой степени приближения появляется возможность редактировать волну с определенной точностью (рис. 5). 
[image: Рисунок 5 - Редактирование формы волны при высоком Zoom-e]
Рисунок 5. Редактирование формы волны при высоком Zoom-e
Режим Multitrack
Второй частью программы является мультитрековый режим, хотя он даже более обьемный и функциональный, чем режим редактирования. Переходим в него, нажимая кнопочку Multitrack, и видим основное окно (рис. 6). 
[image: Рисунок 6 - Основное окно режима Multitrack]
Рисунок 6. Основное окно режима Multitrack
Перетаскивая файлы из браузера в окно аранжировки мы можем редактировать их. На каждой дорожке сразу есть огибающая звука (вверху) и панорамы (посередине), соответственно - Volume Envelope и Pan Envelope. Приятно то, что для каждой дорожки можно устанавливать отдельное устройство вывода (если в системе несколько звуковых плат), а также назначать выход на групповой канал (Bus). 
Для каждой дорожки установлены четыре основных вида (рис. 7). 
[image: Рисунок 7 - Четыре вида для дорожки]
Рисунок 7. Четыре вида для дорожки
Слева направо: Inputs and outputs, он установлен по умолчанию, в этом режиме выбираются настройки входа и выхода дорожки. Effects - изображен на рисунке, это режим эффектов "в разрыв". Sends - режим эффектов посыла. В этом режиме эффект должен быть установлен на каком-то из групповых каналов. EQ - режим эквалайзера. 
Есть еще одна удобная функция - нажав правой кнопкой на любом из клипов в окне аранжировки выбираем Bounce to new track. А затем выбираем All audio clips или Selected audio clip. Соответственно у нас создается новый клип-микс из всего проекта со всеми эффектами и автоматизацией, либо только выбранный клип. 
Переходим во вкладку Mixer: перед нами полноценный микшер (рис. 8). 
[image: Рисунок 8 - Микшер Adobe Audition 2]
Рисунок 8. Микшер Adobe Audition 2
Микшер довольно стандартный и удобный. Для каждой дорожки выведены эффекты "в разрыв", эффекты посыла и эквалайзер, а также стандартные Solo и Mute. С самого края справа находится мастер-канал микшера. Вот, вкратце и все о режиме Multitrack, хотя это далеко не все его возможности. 
Режим CD
Останавливаться на этом режиме не имеет смысла, т.к. он довольно простой и не имеет много функций. Это режим для записи аудио дисков (рис. 9). 
[image: Рисунок 9 - Режим CD]
Рисунок 9. Режим CD
Перетаскиваем нужные треки в окно проекта и нажимаем Write CD (внизу справа). В появившемся диалоге выбираем записать диск (write) или проверить записанный диск (test), либо и то и другое.


Глава 3.2: Wavosaur
А теперь рассмотрим еще одну популярную, на этот раз бесплатную программу. Принято считать, что продукт коммерческий лучше бесплатного, т.к. над ним работало большее количество людей, он более качественно сделан. Однако зачастую встречаются бесплатные продукты, которые могут и конкурируют с платными аналогами. Wavosaur – одна из таких программ.
Поставляется сей замечательный продукт в виде обычного архива, в котором содержится руководство и один файл. На момент написания – это версия 1.0.4.0. Первое, что меня поразило – то, что редактор, по сути, представляет собой маленький exe-файл (всего 500 кб!) и всё! Запускаем его, и первым делом настраиваем звуковую карту. Для этого заходим в Options>Audio Configuration. Появляется окно настройки (рис. 1). 
[image: Рис.1 - окно настройки аудиоустройств]
Рисунок 1. Окно настройки аудиоустройств
Во-первых, приятно то, что есть поддержка как стандартных драйверов, так и ASIO. Во-вторых, очень большой плюс в том, что если в системе есть несколько аудиоплат, можно назначать одну на выходы, другую – на входы. Теперь пришло время открыть наш первый файл. Заходим в File>Open и выбираем файл, который хотим открыть. Редактор поддерживает огромное количество форматов, в том числе и сжатые аудиофайлы (mp3, ogg). 
Итак, мы открыли какой-то аудиофайл и появилось главное окно с графическим изображением нашего файла (рис. 2) 
[image: Рис.2 - графическое изображение аудиофайла]
Рисунок 2. Графическое изображение аудиофайла
В самом окне доступны самые распространённые функции для аудиоредакторов. Здесь мы можем выделять фрагменты, вырезать, вставлять их. Допустим, выделив фрагмент файла и нажав на нём правой кнопкой, выбираем Copy. При этом фрагмент копируется в буфер обмена. Потом опять нажимаем правой кнопкой и выбираем Paste in new file и в новом окне появляется наш фрагмент – в виде нового файла. Далее посмотрим на другие возможности программы. 
Встроенные эффекты и инструменты
Подавляющее большинство эффектов и функций для манипуляции со звуком содержится во вкладке Process (рис. 3). 
[image: Рис.3 - вкладка функций и эффектов]
Рисунок 3. Вкладка функций и эффектов
Здесь доступно около двух десятков различных эффектов для манипуляции. Например, Reverse – делает выбранный участок «задом наперед». Pitch shift – меняет высоту звучания, меняя при этом скорость проигрывания. Также есть популярные функции типа Normalize, которая «вытягивает» громкость до определенного уровня. Или Fade in – плавное нарастание, вместе с Fade out – плавным затуханием. Для применения некоторых эффектов, например для Fade-ов, нужно выделять фрагмент файла, в то время, как другие эффекты действуют на весь файл целиком. 
Также есть интересная вкладка Tools – здесь расположены инструменты для создания циклов (Loops), запись (Record), инструменты спектрального анализа (рис. 4) и статистики, а также другие инструменты. 
[image: Рис.4 - окно анализатора спектра]
Рисунок 4. Окно анализатора спектра
Допустим, чтобы определять уровень сигнала в реальном времени с помощью индикаторов со входа звукового устройства выбираем Tools>Monitor input. Также есть инструменты для синтеза звука. Они во вкладке Synthesis. Самый простой способ создать звук – выбрать Synthesis>Simple. Откроется такое окно (рис. 5). 
[image: Рис.5 - окно простого синтеза звука]
Рисунок 5. Окно простого синтеза звука
В поле Frequency – частота звука, в поле Type – форма волны, в Volume – громкость. Также можно не просто создать этот звук, но ещё и смешать его с исходным файлом, для этого должна стоять галочка на Mix with audio file. 
Внешние эффекты
Приятно радует то, что Wavosaur поддерживает VST-плагины. Причем, реализована структура рэка, наподобие как в Wavelab-e. То есть, возможно прослушивать целую «цепь» эффектов в реальном времени, а не один плагин, как во многих редакторах. Для этого нужно нажать кнопку Rack и откроется окно VST-рэка (рис. 6). 
[image: Рис.6 - окно VST-рэка]
Рисунок 6. Окно VST-рэка
Можно просканировать систему на предмет VST-инструментов, нажав Scan, но я советую загружать их поодиночке, нажимая на кнопку Load VST и выбирая нужный dll-файл. Для удаления плагина из списка выбираем его и нажимаем Kill. В крайнем окне слева и расположена наша «цепь» эффектов. Например, на рисунке 6 сигнал сначала обработается плагином SideChCompSt, а потом KarmaFXDeelay. 
Но пока ещё мы всё равно не услышим никаких эффектов, потому что нужно поставить галочку на панели инструментов напротив Processing. Если мы хотим применить все эффекты нужно нажать Apply. 
Другие возможности
Из других возможностей есть, конечно же, запись. Активируется стандартной красненькой кнопочкой. При записи создаётся новый файл автоматически. К сожалению, во время записи нет никакой информации о том, что запись идёт. Разве только, индикаторы уровня. 
Ещё есть возможность автоматизации громкости. Для того, чтобы можно редактировать изменения громкости нужно зайти в Automation>Create volume. И на нашем графическом отображении файла появляется кривая изменения громкости (рис. 7). 
[image: Рис.7 - редактирование кривой громкости]
Рисунок 7. Редактирование кривой громкости
Ещё есть поддержка Midi в Options>Midi configuration. Но, лично у меня её настроить не получилось. 
Есть интересная функция экспорта в текстовый файл, в который записываются данные о форме волны в виде набора чисел для каждого канала. Также есть возможность экспорта в mp3, правда, используется при этом какой-то внутренний кодек, поэтому из настроек доступно только качество кодирования (до 320 kbps) и всё. 
Итоги
В итоге, получился довольно качественный и функциональный редактор, как для бесплатной программы. Теперь опишу плюсы и минусы программы, на мой взгляд. 
Плюсы: 
· совершенно бесплатный 
· очень маленький размер 
· поддержка ASIO и Windows – драйверов 
· поддержка VST-плагинов 
· поддержка mp3 
· наличие встроенных инструментов (в т.ч. спектрального анализа и статистики). 
Минусы: 
· слабая реализация функции записи 
· малое количество встроенных эффектов 
· ошибки при сканировании vst-инструментов.


Глава 4: Программы для обработки звуковой информации

Глава 4.1: Программы для написания музыки
Не менее важная в функциональном смысле группа программ – секвенсоры (программы для написания музыки). Чаще всего, такие программы используют MIDI-синтезатор (аппаратный внешний или встроенный почти в любую звуковую карту, либо программный, организуемый специальным программным обеспечением). Такие программы предоставляют пользователю либо привычный нотный стан (как, например, программа Finale от CODA), либо более распространенный способ редактирования аудио на компьютере, так называемый, piano-roll (это более понятное представление музыки для людей, не знакомых с нотами; в таком представлении вертикально имеется ось с изображением клавиш пианино, а горизонтально откладывается время, таким образом, ставя на пересечении штрихи разной длинны, добиваются звучания определенной ноты с определенной продолжительностью). Встречаются и программы, позволяющие просматривать и редактировать аудио в обоих представлениях. Развитые секвенсоры помимо редактирования аудио во многом могут дублировать возможности редакторов цифрового аудио – осуществлять запись на CD, совмещать MIDI-дорожки с цифровыми сигналами и осуществлять мастеринг. Яркие представители такого класса программ: Cubase (Steinberg), Logic Audio (Emagic), Cakewalk (Twelve Tone Systems) и уже упомянутый Finale.
Основные возможности редактора Cubase 5.1 – пример рабочего окна программы в режиме просмотра MIDI дорожек: редактирование музыки в реальном времени используя графическое представление информации, высокое разрешение редактора (15360 пульсов на четверть), практически не лимитированное количество дорожек, 72 аудио канала, поддержка VST32, 4 эквалайзера на канал и другие поканальные эффекты, встроенные инструменты обработки с использованием аналогового моделирования (виртуальные инструменты, эффект процессоры, инструменты микширования и записи) и множество других возможностей.
Основные возможности редактора Logic Audio 5 – пример рабочего окна программы: работа со звука при точности в 32 бита, высокое временное разрешение событий, самоадаптируемый микшер аудио и MIDI, оптимизируемый интерфейс пользователя, синхронизация с видео, виртуально неограниченное число MIDI-дорожек, обработка звука в реальном времени, полная синхронизация с MTC, MMC, SMPTE, встроенные модули обработки и автоинструменты, поддержка большого количество аппаратного оборудования, а также множество других возможностей.
В наборе программ пользователя, занимающегося обработкой звука, имеется множество разных инструментов, так было раньше и так будет впредь – универсальных комбайнов для работы со звуком не бывает. Однако, не смотря на все разнообразие ПО, в программах часто используются схожие механизмы для обработки звука (например, процессоры эффектов и прочие). На каком-то этапе разработки аудио ПО, производители поняли, что удобнее сделать в своих программах возможность подключения внешних инструментов, чем каждый раз создавать заново инструменты для каждой отдельной программы. Так что многие программы, относящиеся к той или иной группе ПО, позволяют подключать так называемые «плагины» - внешние подключаемые модули, расширяющие возможности обработки звука. Это стало возможным в результате появления нескольких стандартов на интерфейс между программой и подключаемым модулем. На сегодняшний день существуют два основных стандарта на интерфейс: DX и VST. Существование стандартов позволяет подключать один и тот же плаг-ин к совершенно разным программам, не заботясь о возникновении конфликтов и неполадок. Говоря о самих плаг-инах, надо сказать, что это просто огромное семейство программ. Обычно, один плаг-ин является механизмом, реализующим какой-то конкретный эффект, например, реверберацию или низкочастотный фильтр. 
Из интересных плагинов можно вспомнить, например iZotope Vinyl, - он позволяет придать звучанию эффект виниловой пластинки – пример рабочего окна плагина в среде Cool Edit Pro), Antares AutoTune позволяет в полуавтоматическом режиме корректировать звучание вокала, а Orange Vocoder являет собой замечательный вокодер (механизм для придания звучанию различных инструментов схожести со звучанием голоса человека).

Глава 4.2:Трэкеры
Трекеры – это отдельная категория звуковых программ, предназначенных именно для создания музыки. Структура и концепция построения трекерных файлов очень похожа на принцип хранения MIDI-информации. В трекерных модулях (файлы, созданные в трекерах, принято называть модулями), также, как и в MIDI-файлах, содержится партитура в соответствии с которой должны проигрываться инструменты. Кроме того, в них содержится информация о том, какие эффекты и в какой момент времени должны быть применены при проигрывании того или иного инструмента. Однако, принципиальное отличие трекерных модулей от MIDI-файлов заключается в том, что проигрываемые в этих модулях инструменты (или, точнее сказать, сэмплы) хранятся в самих модулях (то есть внутри файлов), а не в синтезаторе (как это происходит в случае с MIDI). Такой способ хранения музыки имеет массу преимуществ: размер файлов невелик по сравнению с непрерывной оцифрованной музыкой (поскольку записываются только использованные инструменты и партитура в виде команд), нет зависимости звучания от компьютера, на котором происходит воспроизведение (в MIDI, как мы говорили, есть зависимость звучания от используемого синтезатора), имеется большая свобода творчества, поскольку автор музыки не ограничен наборов инструментов (как в MIDI), а может использовать в качестве инструмента любой оцифрованный звук. Основные программы-трекеры Scream Tracker, Fast Tracker, Impulse Tracker, OctaMED SoundStudio, MAD Tracker, ModPlug Tracker.
Программа ModPlug Tracker является сегодня одним из тех трекеров, сумевших стать универсальной рабочей средой для множества типов трекерных модулей 7 – пример рабочего окна программы, на экране: содержание дорожек одного загруженного модуля и рабочее окно сэмплов другого модуля). Основные возможности: поддержка до 64 физических каналов аудио, поддержка почти всех существующих форматов трекерных модулей, импорт инструментов во множестве форматов, 32-битное внутреннее микширование, высококачественный ресэплирующий фильтр, поддержка MMX/3dNow!/SSE, автоматическое удаление потрескиваний, расширение басов, ревербератор, расширение стерео, 6-полосный графический эквалайзер и другие возможности.
Напоследок следует упомянуть о существовании огромного количества другого аудио ПО: проигрыватели аудио (наиболее выдающиеся: WinAMP, Sonique, Apollo, XMPlay, Cubic Player), подключаемые модули для проигрывателей (из «улучшателей» звучания аудио - DFX, Enhancer, iZotop Ozone), утилиты для копирования информации с аудио CD (ExactAudioCopy, CDex, AudioGrabber), перехватчики аудио потоков (Total Recorder, AudioTools), кодеры аудио (кодеры MP3: Lame encoder, Blade Encoderб Go-Go и другие; кодеры VQF: TwinVQ encoder, Yamaha SoundVQ, NTT TwinVQ; кодеры AAC: FAAC, PsyTel AAC, Quartex AAC), конвертеры аудио (для перевода аудио информации из одного формата в другой), генераторы речи и множество других специфических и общих утилит. Безусловно, все перечисленное – только малая толика из того, что может пригодиться при работе со звуком.


Глава 4.3: Программы для копирования и сжатия цифрового звука с компакт-дисков
Для копирования компакт- диска в формат МРЗ, нам понадобятся как минимум две программы:
Граббер - система цифрового копирования содержания AudioCD на жесткий диск; 
Кодер - программа для кодирования получившихся файлов в МРЗ. 
В принципе, позднее понадобится еще одна программа - плеер, ведь проигрывать получившиеся звуковые файлы мы будем опять-таки на компьютере, наш музыкальный центр для этого не подойдет. 
Что касается кодеров и грабберов, то сегодня они чаще всего работают в единой связке. К примеру, все популярные грабберы - Audiograbber, CDex, EAC или WinDAC - имеют в комплекте поставки и МРЗ-кодер, что позволяет кодировать звук с CD в МРЗ напрямую, минуя промежуточную стадию создания на жестком диске громадного файла с копией содержимого дорожки.
От самого граббера требуется не так уж и много.
1. Способность чтения информации о компакт-диске из базы данных Интернет (CDDB) и сохранения ее на жестком диске для дальнейшего использования. Это позволяет в процессе копирования дорожек на звуковой диск давать им имена, соответствующие названию и номерам композиций, а также запоминать эту информацию в тэге будущего МРЗ-файла.
2. Возможность работы с несколькими популярными кодировщиками, с возможностью установления индивидуальных параметров для каждого.
3. Возможность прямого копирования содержимого звуковых дорожек в МРЗ. 
4. Возможность автоматического заполнения МРЗ-тэгов.
5. Возможность сохранения на диске в виде плейлиста (playlist) - обычного текстового файла с расширением M3U или PLS. В таком файле содержится список файлов, содержащих композиции с альбома, и их очередность, что позволяет плеерам проигрывать не отдельные композиции, а весь альбом целиком. Хотя составить такой "плейлист" вы можете сами, в любом текстовом редакторе, - напишите в столбик, в порядке очередности, названия всех файлов (с полным путем к ним), которые вы хотите воспроизвести, и сохраните получившийся список как файл с расширением M3U. После чего спокойно щелкайте по нему мышкой - если на вашем компьютере установлен плеер МРЗ, он запустится автоматически.
Всем этим требованиям удовлетворяют две самые популярные в мире связки "кодер-граббер" - Audiograbber и CDex.
Audiograbber - бесспорный лидер по популярности в нашей стране (еще и потому, что у нас легко доступна "взломанная" версия этой вообще-то защищенной коммерческой программы).
По умолчанию в Audiograbber встроена поддержка только встроенного в Windows кодека от Fraunhofer IIS (хотя в последние версии стали включать и ISO-кодек BladeEnc). При установке же дополнительного кодера от Xing, Audiograbber примет его как родного - таким образом, будут поддерживаться все три популярных класса кодировщиков.


Заключение
Обработка звука бывает разноплановой и зависит от целей, которые вы преследуете. Это может быть подавление шумов, наложение звуковых фильтров, добавление реверберации или дилея, выведение на передний план определённых частот и т.п. 
Наиболее необходимой и используемой процедурой является подавление шумов. Шумы могут быть как внешними, случайно записанными на микрофон фоновыми звуками в помещении с плохой звукоизоляцией, так и внутрисистемными, возникшими вследствие плохого экранирования шнуров и прочего звукозаписывающего оборудования. Шумы имеют свои частоты, диапазон которых сравнительно узок Запись, на которой шумы занимают сравнительно небольшой диапазон, не соприкасающийся с диапазоном других звуков, считается чистой. Запись, на которой шумы звучат почти на всех частотах, считается грязной, так как их практически невозможно подавить без ущерба для нужных звуков.
Фильтры – это эквализационные схемы, которые накладываются на записанный звук. Фильтры бывают статические и динамические. Статические фильтры просто убирают некоторые частоты трека, добавляя другие, а динамические постоянно меняют соотношение частот по определённой круговой схеме, из-за чего звук кажется «плавающим». 
Обработка звука в реальном времени с помощью модулей DirectX оказалась настолько привлекательной для многих музыкантов, что они начали активно использовать именно их, почти «забыв» о существовании основных функций программ обработки. 
Разумеется, семейство программ звуковой обработки не исчерпывается программами Wavosaur и Adobe. Существуют и другие профессиональные программы, служащие тем же целям. Среди них можно особенно отметить WaveLab от компании Steinberg — программу, известную быстротой выполнения алгоритмов звукового преобразования. Она предоставляет также большие возможности по работе с записью Audio CD (звуковых компакт-дисков) и, кроме того, способна работать с подключаемыми модулями VST. 
Довольно широко известна также программа Wave SE, входящая в стандартную поставку некоторых звуковых карт от компании Turtle Beach. Она предназначена в основном для работы с сэмплами, хотя имеет и традиционные возможности звуковой обработки. Однако алгоритмы обработки этой программы весьма далеки от совершенства. 
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· wiki.ru
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· websound/articles/theory/soundfaq.htm
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